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Section I

Introduction
If you’re reading this, you’re either interested in doing research in digitized, historical newspapers so you can
make an amazing, interactive, digital map, or you’re being forced to do research in digitized, historical
newspapers so you can make an amazing, interactive, digital map. Either way, welcome! This guide exists to
help make sense of the wealth of digitized resources available and to translate their riches into effective maps.
The idea is to take a process that can feel daunting and overwhelming and make it feel straightforward and
manageable. By the time you’ve finished reading this guide, you’ll be an expert at working with historical
newspapers and with the databases that compile them. You’ll also be prepared to use the historical data you’ve
collected to make interactive digital maps.

1. Developing a Research Question
The first step of any map-oriented research project is developing a research question. A good research question
is specific: what music was performed at Frederick Douglass’s speeches? Where did touring Fisk Jubilee
Singers ensembles perform between 1885 and 1895? But good research questions also leave room for
adjustment, and expansion. Maybe Frederick Douglass rarely spoke at events where music was also heard; let’s
try adding Booker T. Washington to our research question. And maybe the Fisk Jubilee Singers only toured in
the late 1880s, but we learn they started touring in 1867 and continue touring in the present. Is it too ambitious
to try to map all of their tours? Maybe it is. Similarly, attempting to map all performances of indigineous song
collection during the twentieth century is too broad, yet looking at the song collections of a specific tribe or
First Nation during a set time period is both a wiser place to start and a strategy that leaves room open for
expansion later down the road.

a. Is Your Research Question Mappable? What Types of Data Work Well with Maps?
Since this guide is focused on digital mapping, it is important to consider what types of data work well with
maps. As you begin developing your research question, consider:

Does my research produce data that is geographically disparate?

Maybe you’re interested in performances at a famous theater. Your map is going to show a single
point - that’s not so interesting. Try a timeline, video, essay, or podcast.

Does my research produce data that is meaningful when it’s visualized on a map?

Maybe you’re thinking it’d be neat to see where symphonies were composed in 1933. But then
you realize that Aaron Copland and Arthur Honegger moved around during that year. Florence
Price’s Symphony No. 1 was premiered in 1933, but composed earlier in a different place. And
while a map drawing together lots of symphony-related places might be an interesting way into
the topic, the map itself won’t make an argument; it will serve as a portal for users to access
information. That can be a useful service for a map to provide, but you might just as easily use a
timeline, video, essay, or podcast to the same end.

On the other hand, if your answer to these questions is “yes,” then a map might be right for you.
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Before you begin map-making, consider the geographic scale of your research. Are you interested in
mapping data within a city, within a region, within a country, or across countries? It’s often wise to limit the
scope of your map using tools offered by common mapping platforms like Google Maps and ArcGIS. There is
no need to show viewers the entire world when you’re investigating the locations of Black-owned theaters in
the American South during the 1910s. Knowing the geographic boundaries of your project is crucial before
beginning, as it will save you time in the data collection process and will make your map easier to use. If you’re
interested in a single city, you’ll want to collect specific location data, down to an individual address. If you’re
studying a region, country, or continent, then you might not need specific addresses; you can generate
latitude/longitude pairs that correspond to cities, or collect raster data (quantitative data about an area) at the
county level.

Secondly, consider if and how your research deals with time. Will time be a factor in your dataset,
leading you to visualize each year as a different layer? Will your map require a time-elapse feature, or particular
color-coding in the legend? As a research tool, maps can show change over time. Maps can plot routes, or
distances between birth and death locations. Maps can visualize synchronic (simultaneous) or diachronic
(time-elapsed) relationships. Datasets with a time-based component can easily be mapped and delineated, so
long as you’re careful in your data collection and data cleaning processes. Whether you are looking at specific
concerts, or changes in musical patterns over time, considering how time will be conveyed on your map in
advance will influence how you collect and format your data. The most important question to consider: Is time
a significant variable that will impact the visual presentation of your map? If yes, make sure to standardize the
date and time format in your data collection process.

b. Acknowledging/Identifying Limitations of Your Project Before You Begin
Before you begin primary source research, it is important to decide on the limitations of your project.

Factoring into account how much time you have and want to give to this project, place limitations on your
research. Carefully focused research on a specific sub-topic is more effective than broad-based, general inquiry.

The first limitation to consider is time: what specific time period do you want to focus on. Decide on a
clear timeframe for your research and map within those parameters. It is unrealistic to map one hundred years
worth of data, but more plausible to map a single year, a single city, or a limited number of decades. The time
limitations of your research question will largely depend on how much time and resources you wish to spend on
the project.

The second factor to consider is the geographic limitations of your project. Do you want to include
international data? Are you going to focus on a single city, or a single region? Another limitation to consider is
the extent of your research question. Do you want to focus on a single person, or organization? There are no
right answers to these questions. Your answer will depend on your own circumstances, research interests, and
time limitations.

2. Finding Sources and Doing Research
Once you have identified a research topic, it is best to begin with preliminary secondary source reading.

Maybe you have already begun the secondary source reading process as part of a course, or perhaps you are
beginning it on your own. Either way, use your institution or local library’s online catalog to find several books
and articles on your topic. Read through the sources, and take notes (making sure to record complete citations
for each source) in your preferred note-taking format. Pay close attention to the bibliographies of these sources
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for additional primary and secondary sources that might be useful. Preliminary secondary source reading will
also help you decide which primary source databases to search, and what search terms to use.

a. Finding Primary Source Archives Appropriate to Your Project
Once you’ve completed preliminary secondary source research, you should begin looking at primary

sources. Outside of digitized newspapers, which are discussed in section three, what digitized archives can you
use to find digitized primary (and even some secondary) sources? The table below lists resources for primary
source American history research beyond your college library with a brief description of their holdings.

Resource Name Access Notes Link

Internet
Archive

free If you are looking for a free digital version of
a book start here. Also great for old
recordings and historical books. Collection of
old periodicals and magazines is limited.

https://archive.org/

Hathitrust free Great for periodicals and public domain
books. Always worth a search

https://www.hathitrust.org/

Google Books free Great for public domain books and
magazines. I recommend setting
chronological filters, the older material is the
best stuff on google books.

https://books.google.com/

Archive Grid free Database that helps locate relevant archival
collections quickly. Always look for a finding
aid, see if the collection is digitized, and then
look for an email contact. Many libraries will
send you free scans of archival materials if
you email them.

https://researchworks.oclc.or
g/archivegrid/

Ancestry.com institutional Go to resource for any type of genealogy
research. Search function works best with
specific but not exclusive search terms. Add a
birth date range even if you don't know the
exact birthdate, add a middle initial, add a
birth state. But don't make it too restrictive
b/c many census records are incorrect

https://www.ancestry.com/

Family Search free If you don't find what you are looking for on
Ancestry.com try family search. Most of the
documents are the same through does have
some differences. Site is run by LDS church

https://www.familysearch.or
g/en/

Your Local
Public Library

Free with
library card

Oftentimes there are many digital resources
and databases available for free. If your
school doesn't subscribe, try your local public
library.

varies

Worldcat free Great for figuring out what institutions house https://www.worldcat.org/

https://archive.org/
https://www.hathitrust.org/
https://books.google.com/
https://researchworks.oclc.org/archivegrid/
https://researchworks.oclc.org/archivegrid/
https://www.ancestry.com/
http://ancestry.com/
http://ancestry.com/
https://www.familysearch.org/en/
https://www.familysearch.org/en/
https://www.worldcat.org/
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this book/score

3. Best Practices for Using Historical Newspapers: Towards a Research Methodology
Digital newspapers are a fantastic resource for historical research. The scope of available digitized

newspapers is rapidly expanding, and thus historical newspapers present one of the best primary source
resources available today. This section will outline best practices for working with digitized historical
newspapers. How can researchers and students use digitized newspapers to their advantage? And, what
challenges do digitized newspapers create?

a. Selecting a Database
To begin, which newspaper database should you use? As a researcher, you are also a consumer in the

digitized historical market. You have a choice in which newspaper databases you use, and should always
diversify your searching across multiple databases.

Which database you search first will depend on the chronological and geographical parameters of your
project. Generally speaking, search a large database first and then look at smaller regional databases. The goal
of your initial search should be to discern: Is there enough material about this topic to warrant further
investigation? You may find there is too much material, in which you will need to further refine your search
terms.

The table below provides a quick reference guide to major digitized newspaper databases for American
newspapers from the eighteenth, nineteenth, and twentieth centuries. This table requires a necessary disclaimer:
my experiences with digitized newspapers are informed by my own research topics and institutional access.
Your experience may be different. Newspaper databases that I found useful, may be inaccessible or useless to
you. With that said, I hope that my recommendations can be a useful guide.

Database Access Pros Cons My Opinion

Proquest
Institutional
subscription

Very prominent. Good for
searching individual papers

Individual paper model creates
asymmetric data. Automatic
paper clipping is problematic

Overall, my least favorite
archive

Chronicling
America (LOC) free

Extremely easy to download
pdfs. A good baseline
database to check research
viability

Database is not as complete as
other archives. OCR capabilities
are better in other archives. Not
easy to scan search results and
can be difficult to find selected
text once you open a paper

A good baseline but
won't give you as much
data as other archives

Newspapers.co
m

Paid (free 14
day trial
available)

Excellent and fairly
comprehensive database.
Search functionality is very
good. User interface is
intuitive without automatic
clipping. Zoom functionality
is not glitchy.

Privately paywalled. Institutions
don't subscribe. Connected to
Ancestry.com so the intended
audience is genealogical
researchers. Automatic obituary
clipping option in software is
confusing and unnecessary.

My favorite database, but
I don't like that it's
privately paywalled.

http://newspapers.com/
http://newspapers.com/
http://ancestry.com/
http://ancestry.com/
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Readex
Institutional
subscription

Better than Proquest.
Excellent search interface
with text preview. Highly
customizable search features

Database is not as
comprehensive as
Newspapers.com. Automatic
newspaper clipping is
problematic, and difficult to
save or download clippings.

Pretty decent and worth
your time.

Alexander Street
Institutional
subscription

Good for specialty data sets.
Their 19th century American
Music periodicals database
has a large complete
collection of periodicals,
which are otherwise difficult
to find in complete or
consecutive issues.

Have to double search for
keywords - once you open a
result you have to search again.
Their OCR often misreads dates
so double check listed dates are
correct. Constantly requires you
to re-login via institutional
proxy.

Good for specialty data
sets, search functionality
is more laborious than
other archives

Regional and
State Archives
(see below) usually free

Can be hit or miss. Almost
all are free. Some are
fantastic. Most states have a
historic newspaper archive
and some larger public
libraries also have their own
databases.

Some clearly have suffered
from a lack of funding and use
extremely outdated software
interfaces

Worth your time to look
into, but some are better
than others

University of
Illinois free

Contains both IL state
newspapers and national
collection of popular
entertainment (vaudeville)
newspapers. Good for
specialty data sets, especially
concerning 19th and early
20th century popular music

Individual text clipping is
problematic and encourages
narrow readings. OCR is very
poor, and OCR article
transcriptions appear
automatically.

Overall a good state
archive

Brooklyn Public
Library digitized
newspapers free

One of the best state digitized
newspaper archives. Search
interface is the same as
Newspapers.com.
Completely free and no
proxy login required. Very
easy to re-access search
results

Only has two papers: Brooklyn
Daily Eagle and Brooklyn Life
Magazine.

One of the best regional
archives

Minnesota
Historical
Newspapers free

Good for regional inquiries.
Papers here are not digitized
elsewhere

Search and user interface is
extremely archaic. Extremely
slow to load. Most big MN Good for regional data

http://newspapers.com/
http://newspapers.com/
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papers are in other databases

New York State
Historical
Newspapers free

Good if you've already read
NYC papers and you're
looking for more
information. Primary search
interface is map based

Search interface is the same as
LOC Chronicling American
database. Not extremely
comprehensive Okay

California
Digitized
Newspapers free

Worth your time if your
dealing with data in CA

Automatic OCR transcription.
OCR is generally poor

Decent but could be
better

Cambridge
Public Library free

Use if you've already read
Boston papers and you're
looking for more information

Automatic text clipping is
problematic. Zoom
functionality is glitchy

Decent but could be
better

Elephind free

Composite digital archives.
Pulls search results from
other (free) digitized archives
and allows you to filter based
on archive

Would not recommend as a
main database, good for fact
checking and scoping out
alternate databases

Check to see what else
you could have missed

Old Fulton New
York Postcards free

Mostly New York papers
with some others thrown in.
Good if you've looked
everywhere else and still
need more information

One man's personal collection.
Extremely outdated search
interface that is very difficult to
navigate. The most difficult
search interface I have ever
used. Only use as a last resort.

b. Best Searching Practices
Once you have selected a database, it is time to begin searching. If you are searching for an exact phrase,

put the term in quotes. Be aware that historical newspapers often have a somewhat cavalier attitude towards
names; multiple spellings and misspellings of names are normal. If a word or name has multiple known
spellings, put both spellings in quotes separated with “or.”

While searching in the Brooklyn Digitized Newspaper archive for just “Camilla Urso” returned 131
results, adding the alternate spelling “Camille Urso” returned an additional 20 results. Also try searching for
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word truncations such as “Camil* Urso.”

Newspaper search algorithms work best with broad but specific results. In the example above, while I have
specified an exact name in quotes, I have also made my search broad enough to encompass multiple spellings
and misspellings.

For more information on the basics of digitized newspaper searching, please see my video tutorial on
this topic: https://www.youtube.com/watch?v=RRYTlkMQBz0. In this tutorial, I walk you through my own
searching process for digitized newspapers.

c. Optical Character Recognition: Advantages and Pitfalls
Digitized key-word searches rely on Optical Character Recognition (often abbreviated OCR). While

OCR is a powerful tool that allows historians to sort through large volumes of data, it is also an imperfect tool.
When using keyword searches, be aware that OCR can easily miss or misread your search terms.

In this example from the Illinois Digitized Newspaper Collection, the OCR transcription of the text is
nonsensical and unreadable. Therefore, never rely on OCR transcriptions when reading digitized newspapers.
When at all possible, read the original scanned source and click to hide the OCR panel in order to avoid
mis-readings.

https://www.youtube.com/watch?v=RRYTlkMQBz0
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Digitized newspaper searches work best with some search limitations but not too many. Search for an
exact phrase, refine to a relevant time period; but leave some variables open. Don’t specify by city, or refine by
only a single year, or single paper on your first search. A search that is too broad will yield irrelevant results,
and thus create more keyword hits to work through, whereas a search that is too narrow will exclude relevant
results and could cause you to miss crucial information.

d. Research Case Study: Narrowing Down Your Search Results
Considering these research methods and practices, let’s turn to a case study in tailored searching. If I am

searching for information about the nineteenth century dramatic reader Helen Potter, I might begin with a
keyword search for her name in the Readex Allsearch newspaper archive, a relatively comprehensive and
national database. Doing so returns over two-thousand results, as shown below.
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Because “Helen Potter” is a common name, I know many of these results are irrelevant and unrelated. Weeding
through every single result would be inefficient and distract me from finding useful sources. Therefore, my next
step is refining my search results by year.

I know Helen Potter was active in the 1880s, but I’m unsure exactly when she started and stopped
performing. Scrolling down on the left side panel, I’ve chosen to refine my search results from the years
1870-1899, which encompasses the years I know she was active while also giving myself a wide berth of time
on either side. This time filter is both specific but also wider than just a single year. Adding a time filter, cuts
my results in half, narrowing my results from over two-thousand to just over one-thousand.

After sorting my results from oldest to newest, it’s clear that many of my results are still irrelevant. One
of the first results is about a Helen Potter who was a witness for a crime in San Francisco - clearly not the Helen
Potter I’m looking for.

Therefore, I decided to add the word “reader” to my search, which will increase the chance I’m viewing a
relevant result. In order to maximize relevant results, I don’t place the word “reader” in quotes; instead, I place
the word outside of quotes so the search algorithm will search for “reader” anywhere on the page instead of the
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more restrictive phrase “Helen Potter Reader.” Doing so narrows my search down to just over two-hundred
results - a database that is readable and manageable while also being broad enough to widen what I know. Now
that I have whittled my search results down to a much more manageable dataset, I will read through each result.

4. Best Practices for Reading Search Results
Despite the ease of searching in digitized collections, browsing results too quickly can easily lead to

misconstrued data. Depending on the scope of your project and personal resources, sort your search results
either by relevance or chronologically (oldest-newest or vice versa). When reading through search results, the
most important thing is not to cherry pick. Regardless of how you sort your data, read all the search-results on a
page. Don’t rely on text previews or OCR to determine whether or not to view a result. When reading through
results, it can be helpful to set aside or flag detailed articles that you may want to come back to, transcribe, or
quote in the future. Setting them aside in a new tab, allows you to continue browsing without becoming
sidetracked by a single article.

a. The Importance of Contextual Reading
Secondly, always look for context in a newspaper keyword result. Some databases facilitate contextual

reading better than others. If the database automatically clips text into columns, click to view the whole page.
As you read, ask yourself: What section of the newspaper is this in? How does the graphics, text, and size
compare to the adjacent articles, columns, advertisements on the page? Where is the paper is this result located?
Is it a front page story with a large heading, or is it hidden in a back page classified section?

The database Proquest has the most aggressive text clipping interface. Instead of viewing a spread of the
complete paper, If I want to read the December 1881 issue of the San Francisco Chronicle, for example, I am
presented with a list of OCR generated articles (shown below). An automatically generated list of articles makes
contextual reading nearly impossible.
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Furthermore, once I open an article for viewing, Proquest's automatic text clipping makes it impossible
to determine the context of an article. The “Retail Price List,” shown below on the right, provides no context as
to what section of the paper this is from, how this compares to other items on the page, or why this was even
printed. As a historian, pre-clipped newspapers hamper my ability to ask critical questions.
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Instead, while reading select the option to view the whole page. Suddenly, you have to hunt through a
much more complex set of historical information to find the relevant information.

While reading the entire content of a single newspaper issue is usually impractical, try and read at least a
little of the articles around a keyword result. Contextual reading facilitates nuanced historical thinking.
Contextual questions help you make better arguments and make newspapers more convincing evidence within
your larger research questions.

b. How Many Databases Should You Search?
Contextualized searching also means never rely solely on one digitized newspaper archive. Every

digitized collection contains a different set of papers and works slightly differently. Relying on one digitized
archive means your data is more likely to contain blindspots, be incomplete or asymmetric. Depending on the
scope and scale of your research you can consult three digitized collections or fifteen digitized collections. For a
small or medium sized project, a good practice is to consult two national databases and one regional or state
database. If you have the chance to read newspapers in more than one medium, you should take it. While
reading newspapers on paper or microfilm is rare in a digitized post-pandemic research world, reading on
microfilm allows contextual reading in a way keyword searching never can.

c. Treat Your Findings Like Data: How to Read Efficiently
While you read through search results, treat your findings like data. Know which data points are

important, and which you can disregard. Not every keyword result will be helpful. Work to strike a balance
between reading for depth and context, and reading with data-driven efficiency. The more familiar you become
with digitized newspapers, and the more you learn about your research topic, the easier it will be to discern
which results are helpful. As you collect data, make sure to track which database you found a particular result
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in. This not only increases the academic credibility of your work but also ensures you can easily trace your
footsteps back to the original source if needed. It can be helpful to keep a separate document or spreadsheet to
track longer articles that provide good source quotes or results you know you’ll want to revisit again. Some
researchers prefer transcribing extended quotations, but simply tracking the title, paper, date, with a link to the
original article is also sufficient. While this may seem like more work during the research process, later on
when you are searching for that one quote you just can’t quite remember, an extended quotation document,
index, or spreadsheet will come in handy.

5. Towards a Representative Dataset: Limitations of Digitized Research
Finally, recognize that digitized newspaper archives are incomplete. You can’t search for everything, and

that should never be your intention. Using digitized sources with conscientious research practices and diligence
creates representative, but always incomplete and imperfect, data. If you want to do a more thorough search,
consider contacting local historical societies that might have archives of local historical newspapers. Historians
and librarians are often happy to talk on the phone and look something up on your behalf!

a. Are Digitized Sources Neutral? Considering Database Bias in Digitized History
As a digital researcher, considering the ethical implications of digitized history is necessary. The first

step is recognizing that digitized newspapers are not exhaustive. Of the hundreds of thousands of extant
newspapers, only a small portion has been digitized. Digitization is an expensive and laborious process.
Libraries often have to invest in expensive scanning equipment, and spend hours photographing individual
pages and transferring images from microfilm. As a result, understand that the papers you are reading come
from institutions with the time and money to facilitate their digitization.

Questions of privilege and access are intertwined in all digital primary source research. Who chooses
what gets to be digitized? And, what primary sources are more likely to be digitized? The ever increasing
institutional paywall and corporatization of digitized collections means many collections center privileged
voices while excluding marginalized groups both from accessing the collections and being included in their
catalog. Knowing this, as a researcher you should consider: in what ways do my research practices
unintentionally center privileged voices? While we cannot change a database collection or its software interface,
we can focus on conscientious, contextual research practices that are fully informed by the limitations of
digitized sources.

b. Further Readings
If you are interested in the limitations of digital sources, consider the following readings for further reference.

Lara Putnam, “The Transnational and the Text-Searchable: Digitized Sources and the Shadows They Cast,” The
American Historical Review, Volume 121, Issue 2, (April, 2016), 377–402

Katherine Preston, “Digital Databases for English Language Newspapers in the United States,” Nineteenth
Century Music Review, Vol. 13, (2016), 405-419.

Section II

1. Turning Your Data Into a Map
Now that you have a usable database, how do you turn that data into an effective map and what software

should you use?
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a. Mapping Preparation: Cleaning Up Your Data
Before you move onto map-making you need to make sure your data is standardized. This process is

known as data cleaning or data prep. A standardized data set ensures your data will show up on your map and
you won’t run into unnecessary hurdles in later stages. An effective map starts from a clean and standardized
database.

If your data involves specific dates consider: Does my dataset use a standardized date format? Either
MM-DD-YYYY or YYYY/MM/DD or some variation. If not, you can easily fix this in google sheets by
clicking format → number → More formats → More date and time formats → click the format you want and
hit apply.

If your data utilizes repeated words such as places, names, or pieces of music make sure every iteration
of that word has the exact same spelling (including accents, dashes, spacing, and capitalization). A mapping
software will read irregularities between terms as separate items, creating unnecessary categories in your map.

Use Control+F to find similar pieces of data (addresses, names, venues, institutions, etc.) and ensure that
they’re all entered correctly. Note that you shouldn’t use the entire term (“Theatre des Champs-Elysees”)
because if there’s a typo in one entry, then it won’t be found. Rather, use what seems like a unique part of the
name (“Elys”) to check on the rest of the name. If you find multiple spellings, use the find and replace feature to
standardize. Besides for spelling irregularities, check for extra spaces, differing uses of punctuation, accent
marks, etc...

When possible, each column in your data set should represent one variable. Mapping softwares work
best when they can easily identify the function of every column. Separate cities and states into separate
columns, and put longitude and latitude in separate columns. If your dataset includes pieces of music, separate
the composer and piece name into separate columns. You can easily divide data using the text to column feature
in google sheet or excel (data → split text to columns). If you haven’t already added geographical coordinates to
your dataset, do it now. I would recommend including both the place name (city/state, or address) and
geographical coordinates (lat/long) in your dataset.1

Lastly consider the structure of your database: What is the purpose of each column in your data set? Do
you want to include any further classification in your database? It is important to understand that the structure of
your database directly correlates to the visual presentation of your map. If you want to color code and filter by
performances of a specific composer, you will need a separate column for composers. Adding classification to
your data can be extremely beneficial at this point. You may want to classify your data by type of concert, type
of repertoire, type of event, etc… Classifying your data allows for easy filtering once you begin making your
map.

b. Considering Copyright
As you begin to approach the map-making stage, it is time to consider copyright and citation issues.

Firstly, does every line in your dataset link to a citation? Researchers in the humanities and social sciences cite
according to the Chicago Manual of Style. If you want to use a different citation style you can, but make sure
your citations are consistent. Choose one style and stick to it.

Secondly, if you intend to use any images or media in your map, make sure the works are public domain
or you have obtained usage rights. Any image you use, including public domain images, should have a full
citation. If you intend to use any images from archival collections, especially digitized archival collections,

1 If you are working with Tableau you do not need lat/long coordinates since Tableau calculates location based
on City, State, or Zip code.
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make sure you have permission to use the images. Do not assume media is public domain. If you are unsure,
email the archival collection or respective body, state how you intend to use the images in questions and ask
about their image reproduction policies. Copyright questions also apply to any custom basemaps used in your
map. Make sure the map is public domain, and you’ve included a full citation.

c. Working Backwards
Before you begin making a map, think back to your research question(s). What is your map trying to

show, argue, offer access to? The answer will help you decide how to organize your data, how to visualize it,
and how to contextualize it. You’ll need to ask other questions, too. As a test, choose 5-10 pieces of data and
hand-draw a very rough map that includes a mock-up of how the data will look. When a user clicks on a marker
or an area, what will they see in the resulting pop-up window? Do you want to embed media into your map? If
you plan on presenting your data in layers, what would ideally be included in each layer? Keep in mind that you
don’t need to limit yourself to a single map. You may find your data requires several different maps each with a
different focus and argument. After answering these questions, you’ll be able to approach the next few steps of
the process with a clearer sense of purpose and design.

d. Which Mapping Software Should You Use
Luckily, the emerging prevalence and popularity of digital humanities means you have multiple options.

Read through the following table and decide which software makes the most sense for you. Look back at the
paper mock-up you made, if you visualized a complex map with intricate pop-ups/tooltips, and multiple time
sliders or color gradients, ArcGIS might be the right tool for your project! If you don’t have access to ArcGIS,
try using QGIS or Tableau. QGIS has complex mapping skills similar to ArcGIS, but Tableau is more
web-friendly and easily shareable. If you are just starting out with digital maps and want to put together a
simple project, Palladio or StoryMap JS might be the right tool for you!

The Pros and Cons of Major Mapping Softwares

Software
Name

Access Pros Cons

ArcGIS Institutional Industry standard, extremely
versatile. If you have access, you
should use it.

Learning curve is steeper than other
mapping platforms

QGIS open-source Open source alternative to
ArcGIS.

No web option, maps are not as easily
shareable. No comparable Story Map
feature like ArcGIS.

Tableau Free option Interface is intuitive but also
capable of processing complex
data. Easily shareable.

Tooltip capability is limited, especially if
you have multiple events at the same
location. Ultimately not as sophisticated
as ArcGIS

Palladio free Great for first time map makers.
Simple and easy to put together

Unable to make complex or highly
customized maps.

StoryMap JS free If you don’t have access to
ArcGIS and want to make a story
map, try this platform. Extremely

Map is not customizable. Not the right
platform for complex, multidimensional
maps.
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easy, no mapping skills required.

2. What Makes a Map Effective?
Once you have decided which software to use, you need to consider what makes a map effective. Good

maps have a clear purpose. They synthesize large, complex datasets into a clear visual argument. A good map is
nuanced, but not overly complex. The argument your map makes should be clear with a little explanation. Maps
with too many symbols, or legends can be confusing to a reader. Therefore, as you begin the map-making
process remember it is okay to make more than one map. In fact, your dataset probably requires more than one
map - each with its own specific sub focus.

a. Maps as Arguments
Most maps make arguments. Consider: What argument does my data make? Your argument may not be

clear until you visualize your data into a preliminary map. You may find your data doesn’t make an argument. If
that is the case, you will need to consider why and decide whether you need to refine the focus of your map or
of your dataset. Just as an essay, a podcast, or a video can present an argument - a map can also present an
argument. Show your map to a friend or colleague and explain your argument. Is your argument clear? Is it
easily understandable? Is it comprehensible by a third party with little to no background knowledge in your
topic?

Furthermore, it is important to understand that maps are a subjective interpretation of a dataset. As Mark
Monmonier argues in his book How To Lie With Maps, “a simple map is but one of an indefinitely large number
of maps that might be produced for the same situation or from the same data.” Make multiple maps from your2

data. How are the maps different? In what ways do your cartographic choices create bias or work to serve your
argument?

b. How Do You Map Sound?
Since this is a music focused guide, the specificities of mapping sound must be considered. In what

ways is mapping sound different from mapping events? How can you map sound in a visual map?

c. Six Functions of Musicological Maps
Musicological maps can be pedagogical, research focused, or a form of activism. Professor Louis

Epstein argues that musicological maps generally fit into one of six functions:
1. Maps for pedagogy: Immersive/Affective Experience
2. Pedagogical storytelling
3. New research insights and arguments
4. New research questions
5. Archive/Database interface
6. Activism and Public Outreach

Consider that the best, and most effective maps, often fit within multiple categories and serve more than one
purpose.

d. Considering the Viewer Experience
As you begin designing your map you will need to consider design principles. While your dataset may

be large or complex, maps with too many symbols, legends, or color schemes can easily overwhelm or confuse

2 Mark Monmonier, How To Lie With Maps, (University of Chicago Press: 2018), 2.
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viewers. Consider the experience of a viewer looking at your map for the first time. Your map should strike a
balance between being exploratory without being overwhelming. If you want to convey multiple facets of your
dataset, making multiple maps might be the best way to convey complex information in an accessible manner.
When at all possible try and make accessible design choices. Allow for custom scaling, and customizable
basemaps in case viewers have different accessibility needs.

e. Examples of Effective Digital Maps
Now, let’s look at some examples of effective digital maps. If you want a full list of resources, check out

the Digital Humanities Models page on musicalgeography.org.

3. Mapping in ArcGIS
This section is a tutorial section, designed to answer your questions and help you make the map(s) you want.

a. ArcGIS Pro vs. ArcGIS Online
The first step is deciding whether to use ArcGIS Online or ArcGIS Pro. Unless you want to make

extremely complex maps, you should use ArcGIS Online. If you start using ArcGIS Online and realize the
platform is too limited, you can always switch to ArcGIS Pro at a later date. While both programs have similar
capabilities, ArcGIS Pro is a desktop program that allows for more complex analysis. ArcGIS Online is an
abbreviated version of ArcGIS Pro. It has the same core features, but is an easily shareable, web-based
platform. If you do decide to use ArcGIS Pro, be aware that ArcGIS Pro only works on a Windows operating
system.

b. Basics of ArcGIS Online
To begin, create a new map in ArcGIS Online. To add data, click Add → Add Layer from File. You

should download your data as a CSV file for easy upload.

Once you upload your data, use the symbols next to your layer to refine your map.

These symbols allow you to (from left to right): show legend, view data, change map type, filter data, enable
data clustering, or perform data analysis.

https://musicalgeography.org/dh-models/
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You can also use the menu bar at the top to add another layer, change the basemap, or share your map.

Tutorials:
Esri’s Learn ArcGIS site is a great resource for ArcGIS questions or tutorials. If you are just starting out, try the
following tutorials:

1. Get Started with ArcGIS Online
2. Map a Historic Cholera Outbreak
3. Get Started with ArcGIS Online Youtube Playlist

c. Resources and Advanced Tutorials for ArcGIS Online

Table of Contents For This Section:
1. How to Configure Pop-ups and Tooltips

a. Adding Images to Tooltips
b. Adding Youtube Clips to Tooltips

2. Creating Hosted Feature Layers from Google Sheets
a. Searching Feature Layers
b. Creating Time Aware Feature Layers for a Time Slider

3. Adding Custom Basemaps Using Mapbox
4. Making Maps Public

How to Configure Pop-ups and tooltips:
Click on the three blue dots to the far right under the title of your layer. Then scroll down to “configure

pop-up.” This will allow you to edit the info window.
Within the “Configure pop-ups” Menu, selecting “Configure attributes” will

allow you to select which information you want to see and arrange each category
in the order you like. You can also edit how each category title will appear.

Adding Images to Tooltips:
1. Make sure that you’ve entered an image URL in the database for each

venue/event that you want to map. These can be URLs from external sites, or from
a PUBLICLY shared Google Photos album.

2. Export and upload the CSV as normal.
3. Under the “Configure Pop-ups” menu, scroll down to “Pop-Up Media.”

Click Add Media→ Image.
4. In the window that appears, the title and caption are optional and up to

you. For URL and Link, click the small plus sign to the right of each box and
scroll down to select “Image {ImageLink}.” This connects the info window to the
Image Link column of the database, where you pasted the URL.

5. Hit OK to save within the window, and then make sure to click OK again
in the “Configure Pop-Up” window to save your changes.

6. If you want to change the image title, etc., click the small gear icon under the Pop-Up Media section to
make edits. Note that unless there’s a separate column for it in the database, any words that you write
will be the same across all points on the map.

https://learn-arcgis-learngis.hub.arcgis.com/
https://learn.arcgis.com/en/projects/get-started-with-arcgis-online/
https://learn.arcgis.com/en/projects/map-a-historic-cholera-outbreak/
https://www.youtube.com/playlist?list=PLGZUzt4E4O2IJt1O_OTDFR-3dUpiCZGKf
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Adding Youtube Clips to Tooltips:
In a “Media” field, include the following code around a Youtube link:

<iframe width="280" height="157.5" src="https://www.youtube.com/embed/RmfdXF7zWlI"
frameborder="0" allowfullscreen></iframe>

Creating Hosted Feature Layers from Google Sheets:
1. To create a hosted feature layer, go to your arcgis online “content” page and clicking “add item” –>

“from cloud drive.”
2. Next, go to the drop-down menu that says “CSV” and select your desired file type, presumably a google

sheet, search for and select your desired file, and follow the instructions from there.
3. Once this feature layer is created, you can add it to a map by going to add –> search for layers.
4. A hosted feature layer does NOT automatically sync with google sheets, and a map using a hosted

feature layer does NOT automatically sync with changes made to that hosted feature layer. In order to
sync a map with a hosted layer automatically, you can click “more options” (the blue ellipsis) on the
layer from within the map that you’ve added it to and then adjust the refresh interval.

5. In order to sync a google sheet based hosted layer with its original sheet, go to the hosted layer and click
“update data” –> “overwrite entire layer”. Once this is done, the map will refresh automatically with the
new data if it has been set to do so. (See point above)

Uploading a Live Google Spreadsheet (that refreshes automatically) to ArcGIS.com
See: https://www.youtube.com/watch?v=jG37zPui1r4

Searching Feature Layers:
1. First, make your feature layer that you want to search within a hosted feature layer
2. Then, in the web-app editor, go to widgets, hover over the search widget, and click the pencil icon to

configure this widget.
3. Click “add search source” and select your new hosted feature layer.
4. Select your desired search fields (which field you want the users to be able to search) and your desired

display field (the field which will be displayed as possible options when the user is selecting a result to
display from their search) Adjust any other options as desired.

Creating Time Aware Feature Layers for a Time Slider:
1. First, you must make sure that the desired layer has all of the dates in the same format - ambiguity is not

allowed.
2. Select your desired  layer in the map and select “more options” (the blue ellipsis) →  “configure

pop-ups” Then, create a hosted layer and make it time-enabled.
https://doc.arcgis.com/en/arcgis-online/create-maps/configure-time.htm

3. If you get an error message, download the data as a CSV and re-upload it to create the hosted feature
layer that is time-enableable

4. The time slider should show up automatically on the map viewer. To add it to the web-app, simply add
the time-slider widget.

https://www.youtube.com/watch?v=jG37zPui1r4
https://doc.arcgis.com/en/arcgis-online/manage-data/publish-features.htm
https://doc.arcgis.com/en/arcgis-online/create-maps/configure-time.htm
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Adding Custom Basemaps Using Mapbox:
If you want to add a custom or historical basemap to your project, you can do so using Mapbox. Both the David
Rumsey Map Collection or the NYPL Map Warper are good resources for high quality, public domain historical
maps.

1. Once you find the map you want to use, download the map as a GEOTiff file.

2. Then, make a free account on Mapbox, and go to Mapbox Studio.
3. In Mapbox Studio, click New Style → Customize Basic. Then click Layers → Upload Data → New

Tileset.

4. Then drag and drop your GeoTIFF file you previously downloaded and wait for it to upload. Your file
may take several minutes to upload.

5. Once your file has uploaded, then copy the file link
that pops up in the bottom right.

6. Now click Layer → New Layer → Source → None
Selected → Add Source by ID → Paste the file link you
copied in step five and your map should appear.

https://www.davidrumsey.com/
https://www.davidrumsey.com/
http://maps.nypl.org/warper/maps?show_warped=1
https://www.mapbox.com/
https://studio.mapbox.com/
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7. Now click Share → Third party → choose ArcGIS Online in the dropdown menu and copy the
integration URL

8. Next, navigate back to ArcGIS Online. Click Add Layer → Add Layer from Web → Select A Tile Layer
→ Enter the URL you copied from Mapbox. Add Layer and Your map should appear as a basemap.
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Making Maps Public:
In order to make a map public, the layer that you upload needs to be made public (Share→ Everyone), right
when you upload it. Then the map also needs to be made public once you’re done (again, Share→ Everyone).

d. Troubleshooting: What to Do When Your Map Looks Different Than You Imagined
Mapping is a process of trial and error. Inevitably your map will look different than you imagined. Don’t

expect the first map you make to be your final map. The process of map-making is instructive and the more you
map, the better you will get at it. When you get frustrated or stuck, reach out and ask questions. Ask a librarian,
peer, or professor for help or utilize one of the many GIS tutorials available on the internet.

e. Utilizing ArcGIS StoryMaps
Once you’ve completed your map(s), embedding your work in a story map is a great way to share your work. A
StoryMap allows you to add text, and media to your map creating a guided tour for viewers.

To get started, check out the following tutorials:
Get Started with ArcGIS StoryMaps
Quick Tips for Mastering the ArcGIS StoryMaps Builder
Sara Dale’s Instructional StoryMap

f. Creating ArcGIS Dashboards
Another great way to showcase your map is through an ArcGIS Dashboard. An ArcGIS Dashboard allows you
to combine multiple maps, and filters into an interactive dashboard. ArcGIS Dashboards are more data-focused
than a StoryMap and would be a good choice if you don’t want to add a lot of supporting text to your map.

The John Hopkins Covid-19 Dashboard is a great example of how ArcGIS Dashboards synthesize multiple and
complex datasets into a single, easily accessible interface.

https://learn.arcgis.com/en/projects/share-the-story-of-an-expedition/
https://www.esri.com/arcgis-blog/products/arcgis-storymaps/constituent-engagement/quick-tips-for-mastering-the-arcgis-storymaps-builder/
https://storymaps.arcgis.com/stories/88e367676848488ba71d516436011562
https://coronavirus.jhu.edu/map.html
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If you are interested in making your own ArcGIS Dashboard, try the following tutorials:
Create Your First Dashboard Using ArcGIS Dashboards
Five Tips to Improve Your ArcGIS Dashboards

10. Resources for Other Mapping Softwares
If you are interested in using other mapping softwares besides ArcGIS, see the following resources.

Resources for Palladio:
Palladio Tutorials and FAQ
Four Part Youtube Tutorial from the Raynor Digital Scholarship Lab. Part 1, Part 2, Part 3, Part 4
Getting Started with Palladio

Resources for Tableau:
Getting Started with Tableau Public
Make a Map with Tableau
Tableau Mapping 2: Geocoding, Layers, and Basemaps
Tableau Training Videos

QGIS:
QGIS Help and Training

Ensuring Digital Longevity: Is Digital Work Really Permanent?
Digital projects tend to be imbued with a false sense of permanence. It is easy to think digital projects

will be available forever. The reality, of course, is more complex. As our collective digital landscape and the
software it is built on continually evolves, broken links become inevitable. Consider your future intentions for
your project? If you want your project to remain accessible, regular maintenance to the site and project is
essential. Too many good digital humanities projects are inaccessible due out of date software or broken links.
Case in point see Digital Harlem, or The Roaring Twenties.

https://www.esri.com/arcgis-blog/products/ops-dashboard/mapping/create-first-arcgis-dashboards/
https://www.youtube.com/watch?v=GcuojyIMLd0
https://hdlab.stanford.edu/palladio/help/
https://www.youtube.com/watch?v=u1UAOWgLiTI&t=72s
https://www.youtube.com/watch?v=S-mRW3hI1F0&t=204s
https://www.youtube.com/watch?v=m-OVVAm0utE&t=5s
https://www.youtube.com/watch?v=UxB5wgpnHeE&t=36s
https://miriamposner.com/blog/getting-started-with-palladio/
https://github.com/miriamposner/get-started-with-tableau/blob/master/getting-started-with-tableau-public.md
https://github.com/miriamposner/tableau_maps_1/blob/master/make-a-map-with-tableau.md
https://github.com/miriamposner/tableau_maps_2/blob/master/tableau-mapping-2--geolocation-and-basemaps.md
https://www.tableau.com/learn/training/20204
https://qgis.org/en/site/forusers/trainingmaterial/index.html
http://digitalharlem.org/
http://vectorsdev.usc.edu/NYCsound/777b.html


26

Conclusion
Congratulations, you’ve finished reading the guide. Hopefully you now feel equipped to make your own

maps and experiment with digitized newspaper research. In the end this guide is a starting point. Digital
research projects require individual trial and error. You will make mistakes. Your map won’t turn out how you
intended or you will need to re-do your data structure. While digital maps help us make new scholarly
arguments, they also make us better historians, musicologists, and students in the the process.

Authors Note
This guide was written by Maeve Nagel-Frazel under the supervision of Professor Louis Epstein during the
summer of 2021. Previous work on this guide was started by members of the Musical Geography Project from
2015-2019. Please contact the authors at Maeve.Nagel-Frazel@outlook.com or epstein@stolaf.edu with any
comments or questions.

https://musicalgeography.org/the-team/
mailto:Maeve.Nagel-Frazel@outlook.com
mailto:epstein@stolaf.edu

